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Introduction
This third report describes the evaluation of the redesigned Palm Banking
client (design report), which sports a greatly improved user interface and inter-
action style. During the initial analysis (see analysis report) and iterative re-
design real users were not heavily involved in the development process.

To increase the effectiveness of the evaluation a combination of two methods is
proposed. First, usage simulations with HCI experts reviewing the documenta-
tion and second, low-fidelity (lo-fi) usability testing with potential customers
will be conducted, to obtain as efficient feedback as possible in the short time
frame and with the available resources. The field experiments based on stan-
dard tests followed by a brief interview are used to verify the experts’ sugges-
tions. Part of the usability tests should be done in a professional laboratory
with video equipment.

I was really curious to prove the usability of my redesign including new ideas
on how to offer financial services for customers on the move. Some design as-
pects such as the navigation with pop-up menus I judged skeptical and the time
to involve prospective users was overdue. The evaluation of the mobile com-
panion for the Telebanking application – to instantly manage your finances and
investments, anytime, anywhere – may begin.

Figure 0.1 Application launcher with Palm Bank icon and opening of a connection
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1. Evaluation Techniques

a) Choice of Methods
For the evaluation of the Palm Banking client I decided to use usability testing
and expert reviews. I have chosen these techniques as a result of my knowl-
edge and excellent experience with them. The user interface design team which
supported me partly during the evaluation also promotes a mix of methods to
accomplish complementary results. An interpretive evaluation was not suitable
because of the lack of a self running software prototype to get an understand-
ing of the real world. Cognitive and pluralistic walkthroughs were rejected in
favor of a combination of expert reviews and usability tests with prospective
users.

The lo-fi user testing was performed by monitoring consumers’performance
on carefully constructed benchmark tasks in the field and only notes were
taken in comparison to the video and protocol recordings in a lab. To gather in-
formation about the users’ attitude towards the system, investigations with
semi-structured interviews were prepared (see appendix B). Unfortunately I
had not enough time to ask the questions after every test and I decided to inte-
grate the feedback in chapter 2.

The usage simulation should be done by four colleagues with a human-
computer interaction background, but due to heavy workload the evaluation
had to be postponed and is not included in this paper. Their aim was to review
the design report and to spot usability problems based on their broad experi-
ence with bank related systems. They were requested not to provide a detailed
report as usual but to write their comments and suggestions into the report. The
first analysis paper, the animated demonstration and a draft of this document
was handed out to them as well.

b) User Involvement
The recruitment of real users was no problem and I could choose from a pool
of novel and experienced Piloteers with different levels of Telebanking know-
how, various ages and gender. Some test persons used another or no PDA at all
and the home banking experience ranked from none to Videotex respectively
Internet. During two lo-fi tests a couple worked together mainly because of the
English user interface and tasks descriptions. The characteristics of the seven
test users are described as follows:
• Three female (43%) and four male (57%).
• One 20-29 (14%), four 30-39 (57%) and two 60-69 (29%) years old.
• Three had a PalmPilot or Palm III (43%) and one a Psion 5 (14%).
• Two had a mobile phone (29%), but not for PDA communication.
• Two used Internet banking (29%) and one Videotex (14%).
• Four Mac (57%) and three PC (43%) users.
• Five used the Internet at home or at work (71%).
• Three computer beginners (43%) and four experts (57%).
• Two UBS employees (29%), one GUI Designer (14%).
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c) Constraints, Purpose and Validity
Time was the primary constraint for the usability tests and data analysis since
most people were very busy but nevertheless interested in the project. For two
empirical test I was given an explicit time limit. For the field observations no
video camera was available to log user interactions. The off-line tests should
take place in the user’s familiar environment whenever possible. The English
documentation was a more a less severe handicap for about half of the people

The purpose of this evaluation is to find usability problems and to improve the
redesigned Palm Banking client. Engineering towards a target is expressed as
metrics in the form of the expected success rate for the prescribed benchmark
tasks. A percentage bandwidth is defined between novice and expert users to
measure the ease of use against the my anticipated estimates.

Difficulty Novice-Expert Tasks
Easy 100% 4

Medium 90-100% 9

Difficult 80-100% 4

Very difficult 50-75% 3

Table 1.1 Planned level of successfully solved tasks

The expected validity of the findings should be very objective because of two
different evaluation methods and the involvement of a small number of real
users and HCI experts. For the measurements there may be biases in the data
collection since there is a danger to influence or help the users too much during
the test process. Selective data gathering by the reviewers and manipulation of
the evaluation situation by users or evaluators must be considered too.

For the detailed task descriptions including complexity see benchmark tasks in
the appendix A.
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2. Redesign Evaluation

a) Usability Testing
The method for the evaluation I carried out was lo-fi usability testing with
prospective consumers and paper screens. At the beginning of the usability test
users were briefly introduced into the project and the test procedure. They
were further informed about the aim of the test and their rights, including pri-
vacy issues and the freedom to withdraw from the trial at any time. No test ses-
sion had to be stopped although some users skipped one or more tasks for
which they could not find a solution.

All trials were managed with direct observation and subject to the Hawthorne
effect. Even though I took notes, the record of the observations was incomplete
as a result of the single pass at the data collection.

The requisites for all tests were a Palm III Organizer with two styluses, a
PalmPilot prospectus and 1:1 screen mock-ups for most relevant user inter-
faces which were printed in black on green paper to resemble the real display. I
played the computer and handled all communication with the test person. Ev-
erything of the paper prototype was hidden except for the PalmPilot prospectus
showing the handheld device at its actual size, the stylus and the screenshots
for the current situation.

Since the system is still in development not all possibilities were designed and
some screens were missing during the evaluation. The printouts of the user in-
terface were organized by tasks to give fast access during the evaluation. In-
puts were directly written on the digitizer and simultaneously spoken out,
while selecting and tabbing was done with the pen.

Picture 2.1 Cardboard box filled with screen stacks and PalmPilot mock-up including stylus
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The duration of the empirical testing ranged from one to one and a half hour.
Appendix A contains the benchmark tasks the users performed covering almost
the entire client functions. These tasks to evaluate the software were selected
from my extensive Telebanking experience and incorporate a broad portfolio of
everyday jobs mixed with infrequent, more complicated ones. The interview
took approximately 15 to 20 minutes (see appendix B).

b) Analysis of Results
The chosen evaluation technique proved to be sufficient for the virtual banking
system. After the first two usability tests the benchmark tasks had to be formu-
lated more precisely and several missing screens had to be painted to better ac-
commodate all interaction possibilities. In the end the five tests delivered
enough information and I believe the main usability problems were identified.

The trials were in contrast to the the planned expert reviews more subjective to
influences by the tester. No retrospective was done after the usability tests due
to the lack of video recordings. The lo-fi tests were easy and cheap to conduct
and very effective at this early design stage.

All users except two had seen the animated Palm Banking demo in advance
and most people checked out the functionality by exploring the various menus,
pop-ups and buttons. The task to buy securities revealed the high complexity
and information density of stock exchange orders. The identified problems,
questions and comments are listed below for each affected benchmark task or
topic.
2. Login and demo mode

The guest login was not associated with the demo mode, so the wording
and/or presentation must be changed. People guessed the meaning of
“Guest” to start the product trial.

3. Account statement and details
Currency not shown in statement therefore account info checked. Account
information displays currency as well as branch, and the application is con-
sidered for only a small number of objects. What is a UBS Multimat?

4. Account balances
Sum symbol in button not obvious or guessed. Investment type and curren-
cy icons not clear. Present the total under the account and portfolio
overview lists (maybe with a pop-up menu to select the currency). But
what happens with the total when the list doesn't fit on one screen?

5. Account information
Utilize label Type instead of Category identical to the Account Balances
(also applies to the Portfolio Info).

6. Account transfer
Account selections with pop-up menu not intuitive for non PalmPilot user.
The task sequence lead to uncertainty because the transfer must first be
checked (what now, I want to transfer money) and then be placed (has the
order been executed after the exchange rate is presented). This is a com-
mon problem for two step transaction and can be diminished by two differ-
ent buttons. The label of the button unfortunately toggles and the Palm OS
has no disabled interface elements (again due to space constraints). Be con-
sistent for all orders and provide a confirmation when the user cancels a
checked order.
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7. Portfolio statement and position details
Navigation from account to portfolio part causes a definitive navigation
change from pop-up menus to drop-down menus (portfolios overview not
found). What means “Share” in position details? Port. Share, % of Port. or
Port. % might be more understandable. The price label suggested the cur-
rent trading price which was reachable in the full quote via the Quote but-
ton (e.g. previous close or price with time stamp).

8. Portfolio valuation
What is the meaning of the sum symbol? Valuation dialog displays the in-
vestments by currency but what about bonds. How do I continue? Help
icon recognized to get assistance. Context-sensitive aid solves the problem
to open the view sorted by type. Investment type icon unclear. Sum and di-
amond icons are problematic. Use Total, Value or Valuation (Portfolio
Value) instead of sum symbol, but not enough space. Remove Disconnect
button? The total row could be displayed bold.

9. Sell securities from the portfolio
Good reminder for position quantity. Unsure with valid for today (date
from equals to?). Quantity interpreted once as denomination.

10. Quote list and detailed quote
What is the meaning of “SE” in “Swiss SE” (stock exchange, trading
place)? What about the word “mixed” under market? Quote icon not inter-
national. The Bid/Ask output field uses a slash to separate both values
which are also used for prices with fractions.

11. News headlines and story
NSCP guessed as symbol for Netscape. Afternoon story selected with simi-
lar headline. News icon guessed, design it clearer. News information not
found in the menu. Why can I only access news information after looking
at a quote?

12. Chart
Dow Jones (INDU) not found. Is there a direct access to chart without see-
ing the full quote? Will the trading volume be presented for stocks as well?
Yes, possible except for indices through the scroll arrows or the hardware
up and down buttons.

13. Add security from quote list
Symbol SCMN for Swisscom N not obvious. Why not add the security au-
tomatically since only one match was found? How are dynamic quote lists
like SWX Winners or Losers defined? What is the Show button for, show
quote? Portfolio and quote list with same name mixed confused test per-
sons. Dynamic stock lists are managed with the desktop client or main-
tained by UBS.
Why does the dialog to add a security only has a Cancel but no OK button?
If only one security matches the search criteria it is added without the addi-
tional chooser dialog. A single account, portfolio or quote list could auto-
matically be selected too. Does this make sense?

14. Cancel pending order
Unfamiliar with the words pending and executed for orders. No Cancel
Order in menu. Cancel... button not clear enough, use Cancel Order.
The confirmation message to cancel a pending order must have a Yes/No
button pair instead of OK/Cancel (cancel in this context should clearly
stand for no).
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Even with a Cancel Order entry (/J) in the Service menu, the user must al-
ways choose an order first (present the pending orders or display a dialog
with the same orders). Cancel Order dialog with a Cancel button to escape?
Customers should not be animated to cancel their stock exchange orders.
Why can't I just edit a stock exchange order instead of being forced to can-
cel the order and create a new one? Allow editing of pending orders.

15. Executed orders
How much did this order cost me including all charges? Combine pending
and executed orders in one single overview. Do I have to sell the order
with the offered Sell button? Eventually complement order details with
basic calculation data accessible by toggle icons or a pop-up menu.

16. Buy securities
No access to menus and quote lists to get market data. How do I write a “/”
for the price limit with Graffiti? Forgot to set validity. How to search for a
security if symbol is not known?
Provide meaningful defaults for the validity of an order (maybe even cus-
tomizable in the preferences) and extend the Set Validity dialog so that the
user can set both dates in only one dialog step. Allow prices for example to
be entered either with fraction stroke as 36 1/4 or decimal point as 36.25
for US securities.
Use a trigger selector in place of the security input field (display -Not
selected- if not chosen). The Show Quote dialog is opened if the security is
undefined for the requested full quote screen.

17. Preferences
Assumed to be in the Options menu but not found. Is “Last Used” the
name for a portfolio? I would like to express all stock prices in decimals.
The preferences appear logically unstructured and the grouping is not
clearly visible. Either separate the settings in two dialogs (account & port-
folio and quote list & stock exchange orders) or divide the screen in differ-
ent views like the Connection Options by toggle icons. Use bold labels to
group items and apply a plain font for check boxes.

18. Display options
Strange wording for label “List View”. How are updates visualized? Visu-
alize quote updates with reverse video. Update interval not displayed with-
in list. Place an Options button below every quote list instead of the menu
entry under Options.

19. UBS information and contact
Are sender details and sent messages stored?

20. Logout
Was not sure about the Disconnect button on the UBS Information screen.
Is the Disconnect button on every overview screen necessary? User can
simply turn the PalmPilot off to logout. Put Disconnect into the navigation
pop-up menu. Is the disconnect dialog and security question to logout real-
ly necessary?
Skip “Disconnect from UBS” dialog and show confirmation alert instantly
(e.g. Do you really want to disconnect from UBS after 3:21 minutes?). Dis-
play of online time necessary?
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Navigation
The title “Overview” together with the upper right navigation pop-up menu
was confusing. Since the menu to switch views displayed an ever changing
selection, users were unsure about its functionality. On the second level
(with statement or quote list) a go back possibility was desired (plus a
Home button for the main page).
The navigation between functionality modules requires the user to either
step back via pop-up menus, to use the menu bar or menu shortcuts. No
browser-like Back button is provided to get up in the hierarchy.
The sequence of dialogs opening sub-dialogs is not consistent and not al-
ways predictable (e.g. “Quote” vs. “Quote...” buttons). More detailed win-
dow charts are required on the deeper levels to clarify the logic.
Successful navigation with pop-up menus until a problem arose, then
switch to menus only after this dead end situation.

Help
The help icon in dialogs was interpreted by a non PalmPilot user as infor-
mation symbol but not for user assistance. True Piloteers knew about the
help facilities.

Menus
Even experienced PalmPilot users did not frequently access the menu bar
during the test, as most Palm OS programs are usable without menus.

General remarks
Screens are readable and green is very good as background color. The crit-
ics didn’t complain about any visual sugar and the overall aesthetics con-
veyed positive feelings.
The security symbols are better guessable than the nine digit security num-
bers, but not all financial instruments have a stock exchange symbol. Sym-
bols are usually very short, consist of letters and can be readily kept in
memory or being remembered.
Click on the form title tab to see the transaction time stamp was used once
by accident (more a hidden feature). Some lists are missing the header
lines and for consistency, the design should provide equal size for similar
dialogs.
A critical task is the input of a security for buying stocks (lookup or selec-
tor field). Different choosers were shown to select a security for a search
(lookup and add security, show quote) and from portfolio positions (sell se-
curities).

c) Interpretation
During the evaluation two user behaviors became evident. One group followed
strictly the given tasks while the other users were exploring the program and
for example checked out the available menus and buttons. Usually more expe-
rienced customers took the trial and error approach to learn about the possibili-
ties but also novices played with the user interface.

The complexity of the program was manifested by the full menu bar. The use
of the same names for portfolios and quote lists in the task description resulted
in minor confusions. As mentioned earlier, a German version of the interface
would have been familiar for most test persons than the available English one.
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People had as expected the biggest problems with the navigation, especially
when trying to switch from one functionality part to another (e.g. from the ac-
count to the portfolio part as in task 7). The navigation pop-up menus were not
always intuitive and the possibility to go one level up in the hierarchy was fre-
quently overseen and users mostly preferred the View menu from the menu
bar. The conceptual model behind these navigation pop-ups on the overview
and details level was not understood. Users wanted a “home page” together
with a “go back” function (similar to a Web browser). After a test person didn’t
succeed to navigate with a pop-up menu she then automatically switched to the
drop-down menus for the remaining tasks as a typical pattern.

The late addition of the not required services to open the account balances and
portfolio valuation was the second most task that lead to trouble. This features
turned out to be problematic because they were added to the redesign in the
last minute, and were due to space constraints implemented as buttons with the
sum symbol. Few users recognized or guessed the icon to get the requested in-
formation (the difficult tasks 4 and 8). Design tip: don’t add functionality late
in the design process just because you think it’s a cool feature, without careful-
ly considering the whole user interface. When designing desktop applications
the interface preparation for future operations is much easier than for a hand-
held GUI, where screen real estate is an essential design element.

Additional research is needed for the security input respectively selection pro-
cedure for buying stocks. The possibility to enter a symbol, company name or
security number to initiate a search request after pressing the Check or Quote
button were simply not clear. Users expected a security lookup or choice op-
tions that was not visible for them. A professional buyer has less problems en-
tering stocks while novice users prefer the selection after a search query. In this
case I missed the opportunity to respect the two different user levels (basic and
advanced trading level in the preferences).

Figure 2.1 Different security inputs for basic and advanced trading mode (selector vs. field)

The menu bar was used to open the View menu for changing the overview
screen and the Options menu to customize the settings. The operations from
the Service and Edit menus were never executed.
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It was interesting to see the various ways the benchmark tasks were solved.
Sometimes the users found an unexpected answer to solve their problem cor-
rectly which I didn’t predict in the task descriptions. These short cuts were
possible on account of the test data and flexibility of the program.

Difficulty Novice-Expert Tasks Results
Easy 100% 4 100%

Medium 90-100% 9 97%

Difficult 80-100% 4 85%

Very difficult 50-75% 3 73%

Table 2.1 Planned and measured level of successfully solved tasks

I did not differentiate the conclusion by knowledge groups due to the few trials
and balanced experience of the users. All easy assignments were solved with-
out problems while the other difficulty levels revealed more or less the expect-
ed success rate. The question about how to access the demo was responsible
for the not fully perfect result on the medium tier. Users either answered this
issue incorrectly or simply ignored the query. The difficult benchmark tasks re-
vealed more problems than anticipated because of the non intuitive sum but-
tons. The level rated very difficult caused less trouble and the restrictions pre-
scribed for the buy order required the most attention.

The task 4 and 8 (sum button), 13 (add security) as well as 17 and 18 (options)
were once not resolved. Number 2 (demo mode) was partially finished and 16
(buy securities) was correctly submitted by solely one person. The other users
disregarded to fill out the validity or correct portfolio, or in one case failed to
copy the correct price limit. This reiterates the importance to propose meaning-
ful defaults for stock exchange orders.

d) Limitations
Effective low-fidelity usability testing requires a deep understanding of the
software to be evaluated and a minuscule test preparation when playing the
silent computer. Expect that at least one or two screens will be missing during
each trial because you can’t predict all user actions.

Form filling is notably difficult since a lot of interaction takes places which is
not under your control. For me this is the main limitation I experienced during
the evaluation. Software with navigation and information retrieval (e.g.
overviews, statements and details) is without difficulties. But systems depend-
ing a lot on interaction dialogs and form fills, which require the user to enter
data (e.g. account transfer and stock exchange orders), are far more complicate
to foresee and test without interfering with the user’s behavior. In every experi-
ment I always had to explain at least once the actual contents of a dialog where
the customer could type in data.

Be ready for everything and don’t forget that even your paper computer might
crash, since a strong sneeze could blow away your screen stacks or your card-
board box might fall down.
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A good advice is to number all screens on the back, to store them in card sta-
ples chronologically for the benchmark tasks and to make a plan of your card-
board box’ organization. You could also draw a hierarchical system map to un-
derstand the interaction and navigation between all screens.

A usability lab together with 6-8 real users had been ideal for this experiment
to gain more knowledge but would not justify the additional cost. No perfor-
mance aspects can be measured with this method and don’t use pop-up menus
with a preset selection which disturb the user.

Another handicap was the English version of the program and my explanation
or translations affected definitely the tests. To take notes while concentrating
on the session was not easy at the beginning, yet a good organization led to ac-
ceptable protocols. People got used to the relatively slow but human processor.

Interpretive evaluation to understand better the real world cannot be achieved
with observation or usage simulations. To cause as little disturbance as possi-
ble a prototype running on a PalmPilot is essential to learn, how users work
with the system in their natural environment and how the use of this system in-
tegrates with other activities. Improving the design to fit the mobile consumers
environment was almost impossible although half of the tests were done at the
user’s familiar home.

For a further study I would involve HCI experts for usage simulations and do
supplementary usability testing with the re-redesign in a professional laborato-
ry and real consumers. Interviews with these test persons and online user sur-
veys to reach more people will help to shape the product and better meet the
customers’ opinions and their requirements.

The results from the evaluation are very encouraging because merely a minori-
ty of the tested users own a portfolio or have ever placed a stock exchange
order. Evaluation plays an important part in the development process and can
uncover usability deficits early during the design. The software engineering
principle, that the longer a problem remains unrecognized in the system the
more expensive it will be to fix the defect later, also applies to user interface
design. I also learned once more that there does not exist the “perfect” design,
but some interfaces are better suited for the user, her work, her environment
and the used technology than others. This early evaluation also helped me to
verify the user requirements and to test out ideas quickly like the date setting
for the validity of a buy or sell order.

Many supplementary screenshots were required for these tests so the final
mock-up was flexible enough to accommodate the different working styles
(e.g. right dialog of figure 0.1). The benchmark tasks were gradually enhanced
to better suit the users’ environment and language. The tests persons enjoyed
the one hour usability session and were surprised how intuitive the software
felt. They were also impressed by the novel appliance of the PalmPilot and to-
day’s technology.
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3. Summary

a) System Analysis
The original system was not designed as a genuine PalmPilot program respect-
ing the design constraints (i.e. small screen size) and clearly lacked the usabili-
ty and elegance of the built-in software. The user interface was an exact copy
of the browser-based solution with frames and required too many interactions
to perform everyday functions, which were largely hidden behind menus.

The navigation between screens was not natural and numerous actions ended
without a path to continue the work flow. Order dialogs required too much
handwriting input from the users and they were forced to memorize more in-
formation than necessary (e.g.lengthy account numbers). The Palm user inter-
face guidelines were severely violated and the look and feel, including the
wording, was largely inconsistent. The application offered too much function-
ality, was complex and cumbersome to pilot.

A product with such a bad usability could have been easily rejected by the con-
sumers requiring costly redesign cycles to improve the ease of use in future re-
leases.

b) Redesign of the System
The task analysis provided an improved task structure and a simpler navigation
scheme. The user can do most of his work effectively with the stylus and is not
forced to use menus for common tasks. The functionality can not only be
reached via menus but remains accessible through context-related buttons and
tap selections in the interface.

The system’s state is now clearly visible to users. The system presents what ac-
tions the user can take and doesn't hide functionality in menus. From an atten-
tional point of view the next action in a process is made more obvious. Fur-
thermore the user is given many options where he can select items from a
choice and is not forced to type in arbitrary numbers.

The interface applies a direct manipulation interaction style wherever possible
to minimize handwriting recognition input. The overall number of stylus taps
and the amount of data users have to enter has been reduced for all major
goals.

If at all possible, the entire interface is now shown at one time, especially for
the fill-in forms to minimize up and down scrolling. The limited screen real es-
tate is used more efficiently and the visual appearance is more attractive. The
look and feel as well as the wording is consistent and the behavior of the appli-
cation is identical with the resident Palm programs.

The space constraints led to a concentration on the essential aspects of the fi-
nancial service and the redesign featured an optimal mixture between function-
ality and simplicity.
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c) Reflection on the Evaluation
A couple of readers of the analysis report told me that this design would have
been barely usable. Besides the following usability flaws, the redesign was
highly successful and the expected results were exceeded with the exception of
the difficult tasks (see table 2.1).
• The navigation concept failed and users didn't understand my conceptual

model. No “home page” and “back button” were provided.
• The account balances and portfolio valuation were hindered by an obscure

sum button. The underlying concept of the icons to toggle between the cur-
rency and type view was not meaningful for people.

• The security entry field in the buy order dialog is suited for professionals
but not for novices, who prefer a search and lookup mechanism.

• The term “cancel” was accidentally used for buttons and error messages,
causing dangerous situations which could result in the loss of data.

• The wording of interface elements led sometimes to confusion. Business as
well as language specialists will be required to localize the system. Interna-
tionalization won’t be easy as foreign languages consume as a rule more
room than English.

• Minor inconsistencies in the screen layout were unveiled.
• The demo mode was not visible enough to attract potential customers.
• The resemblance icon for news needed a redraw and the quote icon was

not thought for an international audience.

Instead of the one-man show to do lo-fi usability tests I would prefer a video
camera or supplementary observers for data recording in the future. At the be-
ginning I probably helped the users too much but corrected my influence to the
absolutely minimum the more experience I gained (computer normally don’t
talk). Without video recording the retrospective was not as effective as with
laboratory equipment. The informal discussion after the observation was also
very fruitful and disclosed interesting background information. The feedback I
received was very positive and I hope to conduct more usability test in a pro-
fessional laboratory with the redesigned client. The user’ subjective opinions
about the system was also be of interest but the interview questions were asked
sporadically to save time.

The prescribed benchmark tasks proofed as an excellent selection to reveal
major and even hidden minor problems. The things I had misgivings after the
redesign were concluded, such as the navigation or sum buttons. Points that
surprised me, were the poorly designed cancel order process. The tasks were
arranged in a linear manner in place of a more distributed fashion among the
financial service offerings. The users also got clues from the task headers
where to look for the answer. A more mixed order of the standard tasks with no
functionality titles would have made the trial even more realistic and not im-
plied part of the solution, as I learned during one observation.

The evaluation of all aspects for the already extensive Palm Banking system
was quite work intensive. To usability test just selected functions would have
been a clever idea to reduce the work load. During the design only right-
handed people were considered so additional experiments with left-handed
testers are highly recommended.
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One user appreciated the natural task flow for selling stocks (such as opening a
portfolio, selecting a position and selling it), while another test person was un-
sure where to start a stock exchange order, irritated by the numerous buy and
sell buttons. The narrowing down of a task’s flexibility might not be recog-
nized or led to misunderstandings, since in the sell order example the choice of
securities is logically restricted with every step (i.e. all positions, positions of
the chosen portfolio and the selected position). The customer is then forced to
select the correct portfolio to see the desired position. Adding an “All” option
in the portfolio pop-up menu would solve the dilemma and allow the selection
of all marketable positions (target customers usually have a small number of
portfolios with a few holdings).

Building a prototype with HTML and image maps would also have been a way
to visualize the interface for usability testing. English was for some test cus-
tomers a bigger handicap than I anticipated and most problems arose from spe-
cial banking terms (e.g. difference pending between executed orders). Missing
knowledge about advanced transactions like stock trading was responsible for
some misinterpretations during the tests too.

The time spent with real users during the evaluation to improve the usability,
leads to more customer satisfaction, reduced support costs and a better compa-
ny image. Evaluation is a powerful HCI instrument to ensure high-quality user
interfaces and to guarantee more user-friendly software. Finally, playing the
computer is really enjoyable as the designer of the software, but test guidance
can affect user activity and might also be subject to bias.

d) Recommendations
I only make recommendations and present design alternatives for part of the
findings from the usability tests (see 2. Analysis and Interpretation of Results).
The redesign should be improved based on the evaluation for at least another
iteration. Together with the intended expert reviews this evaluation should lay
the ground for the implementation of the first software prototype. Incremental
prototyping is in my opinion best suited for building the final system, since the
Palm Banking client has a highly modular architecture. The overall design is
readily split into an account, portfolio, quote, stock exchange order and support
(i.e. authorization and preferences) module, allowing consumers to tailor the
installation to their needs.

To solve the critical navigation issue a new Palm Bank main view is introduced
a the top level to better match the users’ mental model (figure 3.1 and 3.17).
The so called home page also improves the system image. This entry screen
presents a list with all available overviews and is shown when the consumers
signs in for the very first time. The welcome view can again be customized via
the preferences. The Disconnect buttons on every overview screen were dis-
cussed too and later removed in favor of only one occurrence on the main
overview page.
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The symbols before the words are the same list view icons used in the applica-
tion launcher. An extra Help button or icon provide information about the ser-
vices offered within each module and should answer question like “where can I
place a stock exchange order?”. The term “orders” on the overview page can
lead to confusion because the pending and executed transactions are related to
stock exchange orders and not payments (e.g. benchmark task 3).

A more visible and uniform hierarchy is furthermore achieved by the addition-
al Done buttons on the overview and statement respectively quote list screens
(figure 3.3-3.6) to virtually close the form and return to the previous screen
(browser back button). Unfortunately the back navigation from deep within the
hierarchy depends on this Done button, which can be troublesome as no direct
way is reachable except for the View menu. These push buttons didn’t cause
any problems closing dialogs during the usability tests.

To clearer visualize the current context for the user, the labels of the register
and pop-up menu on the overview level were interchanged. The navigation
pop-up menu remains now constantly named Overview while the form title
clearly states the current list contents. For example the Accounts register with
the Overview pop-up menu containing all other views (figure 3.3). The naviga-
tion with the pop-up menus remains strictly limited to the same level with this
design (figure 3.2).

Figure 3.1 Palm Bank main page with all available overviews and UBS information overview

Figure 3.2 Overview together with account, portfolio and quote list selection pop-up menus
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Figure 3.3 Accounts overview and account statement with Done and Balances buttons

Figure 3.4 Portfolios overview and portfolio statement with Done and Valuation buttons

Figure 3.5 Simplified quote lists overview and quote list with Done buttons
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Figure 3.6 Pending and executed orders overview Done buttons

For the executed orders the descriptions Sold respectively Bought are more
precise than the previous Sell and Buy (figure 3.6).

The login process was streamlined by replacing the Login as radio buttons with
a pop-up menu to receive more space (figure 3.7). The visibility of the two
login modes is decreased but the wording of the labels is unambiguous.

Figure 3.7 Simplified connect to UBS dialog with customer or demo user login and no status

Instead of the sum symbol in the accounts and portfolio overviews I labeled
the two buttons Balances and Valuation. The screen real estate was gained
from the former logout button (figure 3.3 and 3.4). The toggle icons in the ac-
count balances and portfolio valuation were exchanged by more visible Cur-
rency and Type radio buttons (figure 3.8 and 3.9).

Figure 3.8 Account balances with toggle buttons instead of icon buttons
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Figure 3.9 Portfolio valuation with presentation by currency and investment type

The same wording and layout is applied to the account and portfolio info (fig-
ure 3.10). The former way to set the from and to validity date required the user
to tap on either in the left or right side of the selector and was divided onto two
separate dialogs. The corrected version which was supplied during the later
tests offers one joined date picker (figure 3.11). Figure 3.12 presents the full
quote screen with the enhanced News icon.

Figure 3.10 Account and portfolio information with identical layout

Figure 3.11 Combined date picker to set valid from and to date in one dialog
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Figure 3.12 Detailed quotes with better bid / ask presentation and news icon

The misleading Cancel... button was replaced by a Cancel Order... button in the
order details and the corresponding confirmation alert doesn’t include a Cancel
button anymore (figure 3.13). Cosmetic changes were made in the order details
for executed order, the security selection and display options (figure 3.14 and
3.15).

Figure 3.13 Order details with Cancel Order button and confirmation to cancel a pending order

Figure 3.14 Order details for executed order and security selection for add or lookup security
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Figure 3.15 Display Options with list view and show securities pop-up menus

Figure 3.16 Consistent confirmation alerts with Yes/No buttons instead of OK/Cancel

Figure 3.17 Two screen layout alternatives for the main page offering function descriptions

The third suggestion of all three Palm Bank home pages (right screen of figure
3.17) is quite acceptable because the design builds on existing knowledge with
the help button and gives the user some hints about the dormant operations.
Without the short explanations for each overview she will have difficulty on
how to do certain actions like buying stocks. Both order links remain ambigu-
ous and the customers must be informed in advance that payments are not part
of the wireless system. I personally favor the straightforward main page with
help icons and disclosure triangles for accounts, portfolios and quote lists as
presented in figure 0.2.
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Conclusion
Evaluating the system was the most exciting and challenging task during the
whole development of the Palm Banking application. The preparation and data
analysis of the evaluation was very time consuming. The next step is the im-
plementation of a software prototype to prove the feasibility of the entire bank-
ing service. Additional usability tests a in professional laboratory will ensure
that further improvements based on the recommendations and adaptions for to-
day’s Telebanking capabilities do not hurt the achieved ease of use. Palm
Banking has to be fun and exceed customers’expectations.

The evaluation revealed no risky show stopper and the suggested refinements
are easy to fix. To be successful in user interface design, the designer must not
only understand the user, but also know the work activies, environment and
technology. The Telebanking know-how including analyzing user feedback and
usability testing, as well as the intense study of the Palm OS programs proved
invaluable to produce an impressive design within the given restrictions. The
goal to focus on visibility and affordance, the key principles of human-
computer interaction, resulted in an excellent user interface. Future Telebank-
ing products will be measured against this high usability standard.

Designing user interfaces for handheld computers is an emerging market and
mobile computing – supported by wireless communication and maybe speech
recognition – will become ubiquitous in the future.

Figure 0.2 Palm VII with wireless Internet access and innovative main page with tree view
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Appendix

A) Benchmark Tasks
The test user received the paper below without the solutions, difficulty levels
and answers, while the observers was given the whole information.

Introduction

Please solve one task after another and try to think aloud while doing your
work, which helps us to follow your progress. Tell us what you write and say
“click” when you tap on something with your stylus. The aim of this evalua-
tion is not to test you, but to detect jointly usage problems in the software
being evaluated. The system exists only as a paper prototype and the displayed
data might be incorrect or outdated. And finally, forgive the person playing the
computer for not refreshing the screens as fast as your own PalmPilot.

Thank you very much for your cooperation and enjoy this exceptional banking
service.

Startup and Login

1. Turn on your PalmPilot and start the “Palm Bank” application which is al-
ready installed on your device.
Solution: Press on button and start application from Application Launcher.
(check all categories until found). If one of the four hardware buttons is
pressed, the Applications silk-buttons opens the launcher.
Difficulty: Easy.

2. Login as the customer “Maria Meier” or her spouse with the stored pass-
word and the PIN code “4711” to begin your online session. How would
you access the demo mode to first try out the product?
Solution: Connect to UBS and enter PIN code.
Difficulty: Medium.
Answer: Login as guest to run the demonstration.

Account

3. Who is the beneficiary of the “ixMicro Ultimate Rez” payment in the
“Checking” account, which was executed the 28 December?
Solution: Accounts Overview or View menu, Account Statement and
Transaction Details.
Difficulty: Medium.
Answer: Macintosh Users Switzerland in 8023 Zürich.

4. How much money do you have in all your accounts?
Solutions: Accounts Overview or View menu and Account Balances or by
calculating to total.
Difficulty: Difficult.
Answer: CHF 22’518.85.

5. What is the full account number for the account “Taxes”?
Solution: Account Statement and Account Info.
Difficulty: Easy.
Answer: 230 649.722.01M.

6. Transfer US$ 1’500 from your “Checking” to your “US Dollars” account.
What is the current exchange rate?

Evaluation Report Marcel Büchi

Palm Banking Client 25 - 28



Solutions: Transfer Money from Accounts Overview, Account Statement
or Service menu. Enter amount, choose accounts and currency. Check and
transfer order.
Difficulty: Medium.
Answer: 1 US$ equals 1.2884 Swiss francs.

Portfolio

7. How much did you gain or loose in percent with your “SAir Group N”
shares in the “Blue Chips” portfolio?
Solution: Portfolios Overview or View menu, Portfolio Statement and Po-
sition Details.
Difficulty: Medium.
Answer: Loss of 26.5%.

8. What percentage do you have invested in bonds at the moment?
Solution: Portfolios Overview or View menu, Portfolio Evaluation and
Type view.
Difficulty: Difficult.
Answer: 25%.

9. Sell half of your “UBS N” position at best from your “Blue Chips” portfo-
lio. Make the order valid for today without a price limit and keep the other
settings.
Solutions: Sell Securities from Portfolios Overview or View menu, Portfo-
lio Statement, Position Details, detailed quote or Service menu. Enter
quantity, check order and sell stocks.
Difficulty: Difficult.

Quotes

10. Get the last trading price for the “UBS N” stock in the “Blue Chips” quote
list?
Solutions: Detailed quote from Quote List or Position Details, or Show
Quote from Quote Lists Overview, Quote List or Service menu.
Difficulty: Easy.
Answer: CHF 285.50.

11. Read the oldest news story about the Netscape and AOL merger from the
morning of the 23 November. You will find one of the two shares in the
quote list “Tech Stocks” (symbols NSCP and AOL).
Solutions: See task 10. Detailed quote, News view and Story.
Difficulty: Medium.

12. Display the one year chart for the “Dow Jones Industrial” index which is
also in the “Tech Stocks” quote list (symbol INDU).
Solutions: See task 10. Detailed quote and Chart view.
Difficulty: Medium.

13. Add the security “Swisscom N” to your “Blue Chips” stock list.
Solution: Quote List and Add Security. Find and choose stock.
Difficulty: Difficult.
Answer: Not possible because the security is already in the quote list.

Stock Exchange Orders

14. Cancel your order to buy 185 “3Com Corp” shares from the 9 October.
Solution: Pending Orders Overview or View menu and Order Details.
Difficulty: Medium.
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15. Have you successfully sold your “Motorola” investment for US$ 61 3/4
per share?
Solution: Executed Orders Overview or View menu.
Difficulty: Medium.
Answer: Yes.

16. Buy 355 “Apple Computer” shares from the “Nasdaq”stock exchange. Set
the limit to the actual bid price and your order should be valid for one
week from today. Use the “Tech Stocks” portfolio and debit your “US Dol-
lars” account.
Solutions: Buy Securities from Portfolios Overview or View menu, Portfo-
lio Statement, Position Details, Pending Orders or View menu, Executed
Orders or View menu, detailed quote or Service menu. Choose security and
market, enter quantity, set limit (via detailed quote) and select portfolio and
account. Check order and buy stocks.
Difficulty: Very difficult.

Customization

17. Define in the preferences the “Quote Lists Overview” as your welcome
view, and the “Blue Chips” portfolio as your default portfolio for future in-
vestments.
Solution: Preferences from Options menu.
Difficulty: Very difficult.

18. Display the performance view for the “Tech Stocks” quote list and present
the securities by name instead of symbol. What is the update interval for
data in this list? Can you change this option?
Solution: Quote List and Display Options from Options menu or Options
menu for all quote lists.
Difficulty: Very difficult.
Answer: One minute and yes.

Bank Information and Logout

19. Where can you retrieve information about the Palm Banking service and
how could you easily contact UBS?
Solution: UBS Information or View menu and Contact UBS.
Difficulty: Medium.

20. Logout to terminate your banking session and turn off your Palm connect-
ed organizer.
Solution: Disconnect from all overview screens or Options menu. Press off
button or wait for auto-off.
Difficulty: Easy.

Final Word

You just finished your last task. Congratulations for your valuable assistance to
improve the usability of the Palm Banking client. Again thank you very much
for help.
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B) Interview Questions
These semi-structured interview questions were asked after the usability test.
1. What is your first spontaneous impression of this application?
2. Did you experience something very positive?
3. Was there something you really did not like? What would you change?
4. Did you always know where you were in the work flow and what the next

step would be?
5. Did you feel supported by the system and if necessary guided as well?
6. What do you expect from a help system (context-sensitive assistance)?
7. Did you notice terminology or names which you did not understand?
8. Do you have further comments? Did I miss anything important?
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